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Further Features of Microsoft PowerPoint® 2003 

ABOUT THIS GUIDE 
This document introduces a number of popular features in PowerPoint, which are 
not covered in the document An Introduction to Microsoft PowerPoint® 2003. 

It assumes you have knowledge of PowerPoint and have worked through the 
above document which is available from the JB Priestley Building Reception, and 
on the Web at:  http://www.brad.ac.uk/lss/learning/index.php

How to Use This Guide  
 A paragraph starting with this symbol means that there is some mouse 

clicking or typing involved! 

Format A word in bold corresponds to a word on your screen. 
Type Anything that you are asked to type in will be in this font. 
<return> The names of keys on the keyboard are enclosed in <chevron 

brackets>. 

CREATING CHARTS, TABLES AND ORGANISATIONAL 
CHARTS 

Charts are usually created with Microsoft Excel, and tables with Microsoft Word.  
They can be then be easily inserted into PowerPoint using the Copy and Paste 
commands.  Sometimes you may want to create simple charts and tables directly 
in PowerPoint – the advantage is that they will take on the colours and format of 
your slide design. 

Creating Charts 
 Open a new presentation.   

 Click in the Title placeholder and type:   

Creating Charts, Tables and Organisational Charts 

 Click in the Subtitle placeholder and type your name. 

 Save your presentation as:  Further Features 

 Create a new slide. 

 From the Content Layouts section in the Layout Task Pane, 
select the Title and Content layout (see opposite).  

 In the Title placeholder type:  Creating a Chart 

 Select the Insert Chart icon from the Slide content 
placeholder.     

This starts a separate chart-making program called Microsoft Graph.  A 
sample chart now appears with sample data in a separate data sheet window. 
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We will create a very simple chart: 

 Delete row 3 – click on  to select the row and then press the 
<Delete> key.   

 Now delete row 2. 

 Click in the cell containing the words “1st Qtr” and replace them with Eyes  

 Continue to edit the data in the data sheet until it looks like the one below. 

 A B C D 
 Eyes Ears Nose Mouth

 80 17 2.9 0.1 
Notice that as you alter the data, the chart changes to match. 

 Hide the datasheet by going to the View menu and selecting Datasheet 
(you can easily display the datasheet again by repeating this action). 

The type of chart can be altered by choosing Chart type… from the Chart menu 
and the look of the chart can be altered by choosing Chart Options.... These 
windows will be familiar to Excel users! 

 From the Chart menu chose Chart Options. 

 Click on the Titles tab, then in the: 
Chart Title: box type:  How We Receive Information 
Value (Z) axis:  box type:  Percentage of Information 

 Click on the Legend tab and take the tick out of the Show legend check box. 

 Click on the Gridlines tab, remove any ticks from the checkboxes and then 
click on OK. 

 Click outside the chart area to close the 
Micrsoft Graph program – the PowerPoint 
toolbars should return. 

Your slide should now look similar to the one on 
the right. 

 Save your presentation. 

Creating Tables 
 Create a new slide after the Creating a Chart slide.  

 From the Content Layouts section in the Layout Task Pane, 
select the Title and Content layout (see opposite).  

 In the Title placeholder type:  Creating a Table 

 Select Insert Table from the Slide content placeholder.– this 
starts a separate chart-making program called Microsoft 
Graph. 

 In the Insert Table window that appears, choose 3 rows and 3 columns. 
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 Click OK.  Notice that the Tables and Borders toolbar appears. 

 Click in a cell to add text - enter the text as shown below. 

TYPES OF 
AUDIENCE 

Uninformed Informed

Friendly Easiest Easy 

Hostile Hard Hardest 

Aligning and Formatting Text 
At present the text is aligned with the top of the cells. To align it with the centre of 
the cells: 

 Click somewhere in the table. 

 From the button in the Tables and Borders toolbar choose Select 
Table. 

 Still in the Tables and Borders toolbar, click on the Center Vertically  
button. 

Now we will make the text in the first row and first column bold: 

 Select the words in the first row, being careful not to select the lines between 
the columns as you may resize the columns.  If this happens click the undo 
button  and try again. 

 Click on the Bold button in the formatting toolbar. 

 Now make the words in the first column bold. 

Altering Borders (optional!) 
The borders and shading of individual cells can be altered by choosing Borders 
and Fill…from the  button in the Tables and Borders toolbar.  This works 
in the same way as in Word or Excel. 

 See if you can alter the borders so that 
your table looks like the one opposite! 

 When you have finished, Save your 
presentation. 

Creating Organisational Charts. 
 Create a new slide after the Creating a 

Table slide.  

 From the Content Layouts section in the Layout Task Pane, 
select the Title and Content layout (see opposite).  

 In the Title placeholder type:  Creating an Organization Chart 
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 Select Insert Diagram or Organization Chart from the Slide 
content placeholder.  The Diagram Gallery will be displayed. 

 In the Diagram Gallery window, select Organization Chart 
and then click on OK. 

Notice that an Organization Chart is displayed inside the 
drawing border and the Organization Chart toolbar appears. 

You are now going to produce the ‘Organisational Chart’ as shown below. 
Steps for Creating 

Effective 
Presentations 

Plan Prepare Present 

 

Audience Illustrations Humour Build Rapport 

Please refer to the section Organisation Charts and Diagrams in the document 
Graphics in Microsoft® Word 2003 for help with: 

• Selecting Individual Shapes 

• Adding or Deleting Shapes 

• Changing the Layout 

• Changing the Font and Colour 

• Adding Text to a Shape 

This document is available from the JB Priestley Building Reception and on the 
Web at:  http://www.brad.ac.uk/lss/learning/index.php  

Further tips:   

• Once you have clicked inside a shape, text can be selected using the mouse 
and then formatted using the Formatting toolbar. 

• To ‘close’ a shape (leaving it selected), press the <Esc> key. 

 You may wish to explore the other features within the Organization Chart 
toolbar. 

ADDING LINKS 
With PowerPoint you can easily add links to other slides within the presentation, 
other files, or to web pages. 
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Adding a Link to Another File 
First, we will create a new Word document that will give an “attention-getting 
opening”: 

 Click on the Show Desktop icon  next to the Start button in the taskbar. 

 Find the Word icon on the desktop and double-click on it to start it. 

 In the new document that appears type: Hello!. 

 Change the size of the text to 72 point. 

 Make sure the text still selected, then from the Format menu, choose Font. 

 Click on the Text Effects tab, choose Sparkle Text from the list of animations 
and then click on OK. 

 Save the document with the name “Opening”, in the My Documents folder. 

Now we will add a link to this document from our presentation. 

 Bring the presentation back onto the screen by clicking on the PowerPoint 
button in the taskbar. 

 Select Slide 1 (Title slide) and make sure that you are in Normal view. 

 Select ‘your name’ in the subtitle placeholder. 

 From the Slide Show menu, select Action Settings. 

 Make sure that the Mouse Click tab is 
selected, and select the Hyperlink to: 
option. 

 Click on the arrow to the right of the Hyperlink to: box, then select Other 
File… 

 Browse to the My Documents folder and select your document ‘Opening.doc’. 

 Click OK, then OK again to close the Action Settings window. 

 Save your presentation. 

 Now select the Slide Show view  button and see what happens when you 
click on ‘your name’. 

 Close the Word window to return to your slide show and then press the <Esc> 
key. 

We will now create another slide ready for the next section. 

 Select Slide 1 and create a new slide with the layout Title 
and Text. 

 Add the title:  The 3 Steps to Creating a Table/Chart 
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 Then type the following bullet points: 

• Create a New Slide 

• Select the required layout 
in the Layout Task Pane 

• Click on the appropriate 
object in the Slide Content 
Placeholder 

Your slide should now look similar to the one above. 

Adding a Link to Another Slide Within the Presentation 
We may want to create a link on Slide 5 to take us back to Slide 2, so as to 
reinforce the 3 steps to creating a table/chart.  We could put the link on an 
existing word as we did in the previous paragraph, but this time, we will create an 
Action Button. 

 Select Slide 5 (Organisational Chart).  Make sure you are in Normal view. 

 From the Slide Show menu, select Action Buttons and choose the ‘Home’ 
 button. 

 Click somewhere in your slide to create the Action button (you can move it 
later).  The Action Settings dialogue box appears automatically. 

 Click on the down arrow to the right of the Hyperlink to: box, then 
select Slide…   This brings up the Hyperlink to Slide window. 

 Select Slide 2 (The 3 Steps) from the list and click OK. 

 Click OK again to get back to your slide. 

 Resize the button by dragging any of the white resize handles. 

 Save your presentation. 

 Now select the Slide Show view  button and see what happens when you 
click on the action button. 

Adding a Link to a Web Page 
 Make sure you are in Normal view. 

 Select Slide 5 (Organisational Charts). 

 Select the word ‘Illustrations’ in the bottom row. 

 From the Slide Show menu, select Action Settings. 

 Make sure that the Mouse Click tab is selected, then select the Hyperlink to: 
option. 

 Click on the down arrow to the right 
of the Hyperlink to: box, then scroll 
down and select URL… from the list. 
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 In the Hyperlink to URL box, type 
www.clip-art.com and click OK. 
(www.clip-art.com is a useful site that 
lists and rates different web sites 
containing clip art.) 

 Save the changes to your presentation. 

 Switch to Slide Show view, then click on the word ‘Illustrations’ to open the 
web page. 

USING THE DRAWING TOOLBAR 
The drawing toolbar is available in all Microsoft Office applications and is a 
powerful tool for creating diagrams and drawings.  Details of how to use the 
drawing toolbar are given in the document: “Graphics in Microsoft® Word 2003”.  
This is available from the JP Priestley Building Reception, or on the Web at: 
http://www.brad.ac.uk/cc/documentation/doc-list/index.php 

CREATING LARGE POSTERS 
PowerPoint can create slides up to 134cm high by 134cm wide.  This allows you 
to create posters up to and including International Paper size A0.  Microsoft 
Word, by comparison, can only print up to A3 size. 

To create an A0 slide: 

1. Open a New Presentation. 

2. From the Slide Layout Task Pane select a Blank slide layout. 

3. From the File menu select Page 
setup… 

4. In the Width: and Height: boxes 
type in the dimensions you 
need. 

5. The Slides sized for: box will 
automatically change to Custom. 

Size Height Width 

A4 29.7 cm 21.0 cm 

A3 42.0 cm 29.7 cm 

A2 59.4 cm 42.0 cm 

A1 84.1 cm 59.4 cm 

A0 118.9 cm 84.1 cm 

6. The table to the right gives the International 
Paper sizes. 

7. You can now create your poster as you would 
do a slide. 
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MULTIMEDIA 

Incorporating Sounds and Videos into a Slide Show * 

As PowerPoint Object 
Sounds/videos can be inserted as an integral part of the PowerPoint file (known 
as a PowerPoint Object).  This is the most convenient method, but can make 
your file size very large - a minute of recorded sound can require up to 10MB of 
memory.  A solution is to save the whole file onto a CD or other large memory 
storage media. 

As Linked File 
An alternative is to keep the sound/video as a separate file and link it to the 
PowerPoint file which keeps the PowerPoint file size small.   

The sound/video files can be stored on a CD or other media.  However if you are 
transporting your presentation, you must remember to take with you all the linked 
files and the applications that run them.  Moreover, PowerPoint will always look 
for the linked files in the same place as it was when the link was created, eg in 
the same folder, another folder, on the ‘D’ drive.  Therefore the files must stay in 
the same places on the computer system relative to one another.  Linking to a 
Sound/Movie file is covered later  

Inserting a Sound/Movie 
The following section explains how sounds can be inserted.  Movies are inserted 
in an exactly similar way. 

 Open the presentation Further Features created earlier in this document. 

 Make sure you are in Normal view. 

 From the Insert menu select Movies and Sounds 

You then have four options: 

Option Details *How Incorporated?
• Sound from 

Gallery 
Takes you to the ClipArt Gallery that includes 
sounds.  From here you can also go to Clips 
Online to find more sounds on the web. 

PowerPoint Object 

• Sound from 
File 

Allows you to browse for a file on your 
computer.  (A library of sounds can be found in 
the folder C:\Windows (or WinNT) \Media.) 

PowerPoint Object 

• Play CD 
Audio Track 

Plays specified track(s) on a CD in your CD 
ROM Drive. 

Linked Object 

• Record 
Sound 

This requires a microphone attached to your 
computer. 

PowerPoint Object or 
Linked Object 
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 For the purpose of this exercise, we will chose Sound from File…  - the 
Insert Sound window will appear. 

 In the Look in: box, locate the C:Documents and Settings folder and then: 
All Users\Shared Documents\Shared Music\Sample Music 

 Select one of the files displayed and then click on OK.  The following 
message will appear:   

 

 Choose Automatically.  A ‘speaker’ icon will now appear on your slide. 

You can choose to have the sound playing for just this one slide, or to continue 
playing for a number of slides.  To select these options: 

 Select the ‘speaker’ icon  and then from the Slide Show menu select 
Custom Animation.  The Custom Animation Task Pane will appear. 

 
 Click on the arrow at the side of the media object, eg 

 and choose Effect Options…. 

 Experiment with the settings under the Effect, Timing and Sound Settings 
tabs. 

 Run the slide show to see the results. 

Adjusting the Volume 
Different sound sources are run with different applications, and you may need to 
alter the relative volume between them.  To alter the volumes: 
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 Double-click on the Volume icon  at the right-hand end of the Task Bar (at 
the bottom of your screen).  If the icon is not visible, click on the  button to 
display it. The following window will appear. 

 
 Adjust the volumes to suit, by sliding the sliders. 

Linking to a Sound/Movie File 
A sound or movie file that exists on your computer, on a CD or other media, 
which can be linked to the PowerPoint file. 
1. From the Slide Show menu select Action Buttons… and then select an 

appropriate button. 

2. Click in the slide.  The Action Settings window will appear. 

3. Make sure that you are on the Mouse Click tab, then click on the Hyperlink 
to option button and select Other file… from the drop down menu. 

4. Select your file, then click OK. 

When the slide show is running, if you click on the Action Button the application 
that created the sound/movie will open and then the sound will play/movie will 
run. 

Recording a Voice Narration or Sound in a Slide Show 
Narration can be added to a single/number of slides in PowerPoint.  You might 
want to add narration in the following cases:  

• A Web-based presentation. 

• For archiving a meeting so that presenters can review it later and hear 
comments made during the presentation. 

• For individuals who can't attend a presentation. 

• For self-running slide shows. 
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To record a narration, your computer needs a sound card and a microphone.  
You can record a narration before you run a slide show, or you can record it 
during the presentation and include audience comments. 

If you don't want narration throughout the entire slide show, you can also record 
separate sounds or comments on selected slides or objects. 

Because voice narration takes precedence over all other sounds, if you're running 
a slide show that includes both narration and other sounds, only the narration will 
be played. 

Tip:  Keep in mind that voice narration is not always the best way to get your 
information across.  Perhaps some people in your audience have computers that 
do not have sound cards, or they may be using a computer located in a noisy 
room; some of your audience may have a hearing impairment, or you might also 
want to use slide notes for each slide. 

Record a Voice Narration 
For this procedure, you will need a microphone.  

1. On the Slide Show menu, click Record Narration.  A dialog box appears 
showing the amount of free disk space and the number of minutes you can 
record.  

 
If this is the first time you are recording, do the following:  

2. Click Set Microphone Level…, and follow the instructions to set your 
microphone level.  

3. Now do one of the following:  

a. To insert the narration on your slides as an embedded object and to begin 
recording, click OK.  If the Record Narration window appears – select the 
appropriate button. 

 
b. To insert the narration as a linked object, select the Link narrations in: 

check box, and then click OK to begin recording.  
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4. Advance through the slide show, and add narration as you go.  

5. At the end of the show, a message appears.  

 
Do one of the following: 

a. To save the timings along with the narration, click Save.  

b. To save only the narration, click Don’t Save.  

A sound icon appears in the lower-right corner of each slide that has 
narration.  

Notes 

• When you run the slide show, the narration will automatically play with the 
show.  To run the slide show without narration, click Set Up Show on the 
Slide Show menu, and then select the Show without narration check box. 

• Because you can't record and play sounds at the same time, while you're 
recording the narration, you won't hear other sounds you inserted in your slide 
show.  

Record a Sound or Comment on a Single Slide 
Note:  For this procedure, you will need a microphone.  

1. Display the slide you want to add a sound to. 

2. On the Insert menu, point to Movies and Sounds, and then click Record 
Sound. 

3. To record the sound, click Record . 

4. When you are finished, click Stop . 

5. In the Name box, type a name for the sound, and then click OK.  
A sound icon  appears on the slide.  

Tip:   To animate the sound so that it plays automatically in an animation 
sequence, select the sound icon, click Custom Animation on the Slide Show 
menu, and then select the options you want. 

Re-record Voice Narration 
6. Display the slide where you want to start to re-record the voice narration. 

7. On the Slide Show menu, click Record Narration. 

8. Press the <Esc> key on the slide that follows the slide at which you want to 
stop your recording.  
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For example, if you want to re-record slides 4 through 6, finish your recording on 
slide 6, click to move to slide 7, and then press <Esc> on slide 7. If you press 
<Esc> on slide 6, you will delete the recording for that slide.  

Pause or Stop Voice Narration During Recording 
9. Right-click, and then click Pause Narration on the shortcut menu. 

10. To resume recording, right-click, and then click Resume Narration.  

Delete Voice Narration or a Sound From a Slide 
11. Select the sound icon  and then press the <Delete> key. 

12. Repeat for each slide you want to delete the narration or sound from.  

Tip:  If you want to run the slide show without its narration but you don't want to 
delete it, click Set Up Show on the Slide Show menu, and then select the Show 
without narration check box. 
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